SUMMARIES OF INTERACTIVE MULTIMEDIA
GRADE 10
SOLUTIONS DEVELOPMENT
1. Producing a Good Document
This lesson is about the basics of word processing. In it you will learn how to use the ribbon in a word
processor and how to apply some finishing touches to a document. The lesson uses an actual letter,
which is worked on and improved.
There are 6 main topics, including:
 Basic file management
 Using the ribbon
 Formatting the document
 Applying finishing touches
 Using templates
 File management and printing
There is a lot of detail to help you become familiar with the ribbon. Each tab is discussed in detail, like
this one.

The formatting part includes typical changes that can be made, such as to font type or colour. There are
also sections on how to check for spelling and grammar errors, insert numbers or bullets, apply spacing
and alignment.
There is quite a lot of detail about page layout, borders, page colours and margins. The review function
is also discussed.

The lesson ends with a detailed description of how to use the many different templates available and to
set up document printing.
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2. Making Professional Changes to a Basic Word Document
In this lesson, get ready to insert and adjust tables, insert and adjust graphs and add final, professional
touches. Using an actual word processed report, the lesson covers:
Inserting and formatting tables

Inserting graphs and making changes to them

Finishing touches, like page breaks, footers, page numbers, inserting pictures and shapes, resizing
images, table of contents and inserting hyperlinks. This covers almost everything you need to know in
Grade 10.

3. Capturing and Manipulating Data in a Workbook
 Do you know how to:
enter data into a workbook?
 Work with worksheets?
 Format worksheets?
Use this lesson to learn how to do these things well.
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Enter all data directly into cells, using columns and rows. This will give each data item a cell address.

It is possible to do simple calculations in any workbook, using a basic formula, like this:

And don’t forget to use the many formatting function built into a workbook, like number, alignment,
font, border etc.

Remember that worksheets can be manipulated to:
 Add more worksheets
 Name and colour code worksheets
 Format specific data types in worksheets
 Add column and rows (or delete columns and rows)
4. Using Functions and Graphs in a Workbook
By the end of this lessons learners will be able to:






Carry out basic calculations in a spreadsheet
Explain and fix error indicators
Insert and perform and variety of fu nctions
Sort and filter data
Create different types of graphs
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Format graphs in spreadsheets

A basic calculation uses a formula that you enter into a cell of a workbook. It can use either actual data
figures or cell references (addresses). A function is a built-in formula that can be typed in using a
standard format or can be selected from a list.
Basic calculation
Function

Sometimes error indicators will indicate that there is an error in the formula or function. You need to
know the common error indicator, like:
#NAME?
#DIV/0!
#REF!
#VALUE!
#NUM!
#N/A
Sorting or Filtering? Learn both of these techniques because they have different uses.
Sort: When you enter data into your worksheet it is often unorganised and is difficult to examine.
To analyse it, you may need to rearrange the data in different ways to answer different questions.
Excel's sorting feature can help you rearrange your data, usually in ascending or descending order,
so you can use it more efficiently.
Filter: Filtering is a way that you can use Excel to quickly extract certain data from your
spreadsheet. Unlike sorting, filtering doesn't just reorder the list, it hides the rows or columns
containing data that do not meet the filter criteria you define.
You can make a graph like this:

Directly from data like this: Learn the steps to do this in this lesson!

5. Making and Showing a Presentation in a Workbook
Here’s what this lesson is about:
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Using an actual presentation in progress, learners can see how to set up and design a presentation.
There is a useful ribbon for all required development and editing.

There are some easy-to-follow steps to insert a variety of items, as shown here:
Insert table

Insert graph

Edit SmartArt

Insert picture

Insert ClipArt

Insert Media Clip

Inserting a hyperlink is a bit different, but still very easy. You can hyperlink to another place in the same
presentation or to another file or even to a website.
Finally, after checking spelling and grammar, check what the presentation will look like: Use the SLie
Show tab, like this:

Last touches can be added, like headers and footers (use Insert tab), page/slide numbers (use Insert tab)
and animations when changing from one slide to another (use Animations tab).
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SUMMARIES OF VIDEOS
GRADE 10
SOLUTIONS DEVELOPMENT

1.

Solutions Development - Word Processing
Word Processing – The Basics
This video shows basic concepts of a word processing and what it looks like, using MS Word. Word
processing is used for making letters, reports, brochures and drafts of do documents to go onto a
website.
Look out for all the tabs in the word processing application, and the ribbon associated with each tab.
Each ribbon has groups of functions. There is also a set of quick links at the top of the pane and the
task bar at the bottom, with things like pages and numbers of words. Look out for the scrolling bar
on the bottom right and the minimise, maximise and close buttons on the top right.
To enter data into a word document, use the keyboard at the cursor. Remember to leave one space
between one word and the next, and one space between a full stop and the next letter. Never press
enter unless starting a new paragraph, because Word automatically starts a new line when the
previous line is full.
Open Office is very similar.

2.

Open and Save a Word Processed Document
To open an existing document in MS Office or Open Office, use File and Open. To save a new
document, use File and Save As. A dialogue box will open; Choose the location (folder) to save to,
and type in the preferred name of the document/file. Now press Save. You will kno0w you have
saved the document when you see the selected name of the document at the top of the page. The
Save As process is almost identical in Open Office and MS Office.
Another option for saving a new document is simply to use the Save function. The same steps will
occur, in the same dialogue box. However, when saving an existing document to a new location, or
when you want to change the name of the existing (old) document (for example, you want to show it
is Version 2 or Final), always use Save As.
There are 2 main ways to make corrections in a document before using Save or Save As. Us e the
backspace key to delete letters or words to the left, and use the delete key to delete letters or words
to the right. If there is a whole sentence to delete, select it first and then use the delete key.
This video also shows how to use the File tab and Print. Once Print has been selected, there will
always be a print preview and a dialogue box giving options for printing, like how many pages to
print and whether to print on one side or two. In MS Office the print preview is on the right, while in
Open Office it is on the left. The dialogue box for printing is also a little different in Open Office, but
it offers the same function sections.
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3.

Make a Document from a Template
This video lesson is about how you can make a document that you can use, like a resume or CV, a
memo, a business letter, from a pre-designed template. To do this, use the File tab, go to View and
select a template from all the available templates in the menu. The example used is letters – select
an apology letter. Once selected, it appears in a preview page, so that you can see if you want it and
then download it. Now the pre-built template of this letter allows you to insert your name, address,
etc. in various fields. Once done, save as a normal document. Open Office works in the same way as
in MS Office, although the menu is different and there are fewer options from which to choose.

4.

Improve a Document with Word Processing
It’s important that a word processed document looks professional. Improve any document with
formatting or enhancing text, or simply move, copy or delete text, as shown in this video. It’s
important to select required text – and this lesson shows all the ways to do that. Use the mouse and
drag or click when the mouse is in various positions. There are also keyboard shortcuts for selecting
words or lines of text. MS Office and Open Office work in similar ways.
To move text – take it from its original position, cut it out using the tool in the clipboard part of the
Home tab, and place it using paste into a new position. There are also keyboard shortcuts for this –
use Control X and Control Z.
To copy text, the original text remains in its place – copy using the Copy button in the clipboard
group of the Home tab, and paste it in a new position. Or use Control C follow by Control Z. The
same processes apply in Open Office.
Use the Replace function to change one word throughout the whole document. For example, in the
Edit group, look for or find “Composition” and replace with “Essay”. It’s a little different in Open
Office, although the dialogue box is very similar.

5.

Format Font
There are a number of ways of formatting font including font type, font size, or font style (like bold,
italic and underlined). As with most editing, the word or portion of text to be formatted must be
selected first.
Use the font group or activate the font dialogue box. Choose one of the many font types, change the
font size – and observe the effect of these changes before even applying them. Notice that in Open
Office there is a slightly different set of steps to change the font.
Change the font style using the individual B, I and U buttons in the font group. Open Office works in
exactly the same way.
It is also possible to change the colour of the font, as long as it is selected first. There are very many
colours from which to choose. Or use a colour to highlight – select the text, such as a word or part of
a sentence, and choose the colour green from the dialogue box to make it stand out. Everything is
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exactly the same in Open Office.
Also apply effects like caps, superscript, strikethrough, etc. to text in this area of the font dialogue
box:

6.

Format a Document with Word Processing – Part 1
This lesson deals with formatting paragraphs. It’s a good idea to work with the show/hide button
turned out. It helps you to see a number of features. The show/hid marks do not show in a printed
form of the document.
Line spacing increases or decreases spaces between lines of text but paragraph spacing increases or
decreases spacing between paragraphs. For line spacing, select the text to edit, work in the
paragraph group in the home tab and work in the ‘spacing’ section. For paragraph spacing, highlight
the whole document (or use control A) - change the spacing before and/or after paragraphs, using
12, 18 or 24 points.
Paragraph alignment can be done using the alignment options in the paragraph group. Make sure
that text is selected, before making an alignment selection. Remember that justify means that text is
aligned to the left and right margins, making it look very neat.

7.

Format a Document with Word Processing – Part 2
Inserting headers and footers, indenting a paragraph, margins, orientation, page layout, page colour
and columns
Page layout tab offers a number of useful groups.
To change page colour: Select Page colour in the page background group
To indent a paragraph: Select the paragraph, use the paragraph dialogue box and follow the steps in
the indentation section (and notice that it is possible to indent from the left and right margins)
To insert a header, that appears on every page at the top: Use the Insert tab and the Header &
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Footer group, open the dialogue box for headers, use one of the pre-set ones or type your own in a
blank header
To insert a footer, that appears on every page at the bottom: Use the Insert tab and the Header &
Footer group, open the dialogue box for footers, use one of the pre-set ones or type your own in a
blank footer. Also insert page numbers in a very similar manner: Use the Insert tab, select Page
Number and choose where you want to position it and what style of page numbering to use.
Apply a watermark to a document: in Page Layout use the Page Background group and go to
Watermark. There are some pre-set watermarks or you can type in your own wording.
8.

Work with Columns and Tabs
Columns are useful for typing articles for a newsletter or magazine. Select text to be made into
column layout. Use the page layout tab, and the page setup group within that. It works quite well to
select “More columns” and then to select the number of columns you want and the width of
columns, in the columns dialogue box. You can also choose to have a line between the columns.
Tabs are very useful to use, to get alignment of a document correct. Don’t try to do tabs (or spacing)
by using the space bar! Use Home, paragraph group and select the drop down arrow - it will give a
dialogue box like this:

It’s really easy to put in tab positions, once selecting this ‘Tabs’ button. Follow the step-by-step
instructions in the dialogue box. The tabs become visible on the rules. Notice how easy it is to take
tabs away when they are no longer needed.
Check the special instructions for setting a leader tab, it’s almost the same process. This is such a
great trick for a table of contents, for example.
9.

Apply Numbering and Bullets in Word Processing
It’s really easy to add numbers and bullets to list items. This makes the items easier to read and gives
them emphasis.
Select the text/list to number/bullet. All that you have to do is:
 Select bullets and choose the style of bullet you like
 Select numbers and choose the style of numbering you like
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10.

Page Layouts in Documents
This lesson uses Page Setup and will deal with:
 Setting and changing margins
 Changing orientation of paper
 Changing paper size
Using page layout tab, work in the page setup group. Activate the page setup dialogue box and then:
1. Set margins using the down arrow next to each margin box, then click OK
2. Change orientation – simply click landscape + OK
3. Change size of paper (from the default of A4); select any size from the list of available sizes +
OK

11.

View Word Processed Documents
There are different ways to view a word processed document. To do this, always use the View tab
and work in the Document Views group.
Choose between Print Layout, Full Screen Reading , Web Layout, Outline and Draft. It’s best to work
in Print Layout because it shows what your document will look like. But using Draft is also good for
doing quick changes.
Multitasking is also possible when using ‘View Documents Side by Side’. With 2 or 3 documents
open, you can see them together. You can scroll together, or you can split one document while
viewing the end of the document. To get out of this split view, double click on the split bar to take it
away.

12.

Use Comments in Word Processed Documents
Comments help when a lot of people are using or reviewing the same document.
Use Review – Comments Groups – New Comment – then type in the comment in the comment
window.

13.

Protect Word Processed Documents
In Microsoft Word, it’s possible to have different levels of protection on a document. Just click on
‘Restrict Editing’ in the ‘Review’ tab and follow the prompts. You are able to stop others from making
formatting and editing changes to the document.
Open Office has similar functionality.
Both are explained in this video.

14.

Integrate other Documents into Word Processed Documents
Putting hyperlinks within a document is a fast and easy way to direct viewers to a different part of
the same document, or to other documents.
This can be easily done in Microsoft Word by right clicking on a selected word or phrase and
selecting the option ‘Hyperlink’ on the dialogue box and then following the prompts.
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In Open Office, you first select the word and then click on ‘Insert’ in the top ribbon. Choose
‘Hyperlink’ and then follow the prompts.
15.

Insert and Manipulate Illustrations in Word Processed Documents
There are four types of images in Microsoft Word, images, clip art, auto shapes and word art. All of
them can be inserted and manipulated within Microsoft Word.
To insert any one of these illustrations, navigated to the ‘Insert’ ribbon and choose the type of
illustration you’d like. Follow the prompts.
Illustrations are inserted with handles on the corners. These allow you to resize the image. In Word
you are also able to manually rotated the illustration by clicking and dragging the green handle.
Word Art allows you to create and insert a fancy heading. It also has handles on the sides allowing
for easy resizing.
To change the fill and outlines of an automatic shape, go to the ‘Shape Styles’ group in the ‘Format’
ribbon. This ribbon will appear when the automatic shape is selected.
Textboxes are useful to use when you only want to type in a small spot on the page. You are able to
rotate and resize the box using the handles on the sides of the box, as well as change the fill and
outline styling.

16.

Add and Use Tables in Word Processed Documents
Tables are useful to structure lists in a document.
To insert a table in Microsoft Word, you need to be in the ‘Insert’ ribbon and must click on the image
of the table. Follow the prompts.
To apply a more attractive format to the table, go to the ‘Table Styles’ group in the ‘Design’ ribbon
and select one that appeals to you.
Another way to change the formatting of a table is to select it, right click and choose ‘Borders and
Shading’ in the dialogue box. A new dialogue box will open and give you the opportunity to choose
different borders and shading options.
To merge two or more cells into one, select the cells, right click on them and select ‘Merge Cells’.
To split a table into to two tables, select the row which you want to be the first row of the new table,
and click ‘Split Table’ found in the ‘Merge’ group of the ‘Layout’ Ribbon.
To convert a table to text, select the table and then click on ‘Convert to Text’ in the ‘Data’ group of
the ‘Layout’ ribbon. Follow the prompts.
To sort the data in the table, select the table and click ‘Sort’ found in the ‘Data’ group of the ‘Layout’
ribbon. Follow the prompts in the new dialogue box which will open.

17.

Create and use Graphs in Word Processed Documents
You need to have your data already collated, preferably in a table, before creating a graph. After
that, the process is pretty simple in both Microsoft Word and Open Office.
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To insert a graph in Microsoft Word, select ‘Chart’ in the ‘Illustrations’ group in the ‘Insert’ ribbon.
Choose the type of graph you want to use and click ‘OK’. Microsoft Word will split your window in
two. One side will show the document and the other has the spreadsheet in which the data for the
graph must be entered. Enter the data in the appropriate columns and delete any excess columns
and rows. Close the spreadsheet once all the data has been entered and the graph will automatically
update. To change any of the formatting or layout of the graph, select the graph and use the
‘Design’, ‘Layout’ or ‘Format’ ribbon.
To insert a graph into an Open Office document, click on ‘Insert’ and select ‘Chart...’. A Dialogue box
will pop up and guide you through the process of choosing a graph and entering the data.
18.

Practical Example: Create a Word Processed Document with Text, Graphics and Data
Before changing any formatting, it’s important to select the text your wish to alter. Then go to the
‘Home’ ribbon and alter the appearance of the text using the ‘Font’ group. To change the spacing
using the ‘Paragraph’ group. ‘Styles’ group gives some preset styles that can be applied to text.
This video also discusses the difference between moving and copying text, and how to insert and
resize images.

19.

Practical Example: Create a Word Processed Document in Different Ways
This video shows how to open Microsoft Word and work in a blank document. It also shows how to
access and use templates. You can do this by clicking ‘File’, then ‘New’ and selecting a template from
the available list.

20.

Demonstrate Understanding using all your Technological Skills in Word Processed Documents
This video revises how to use the following functions:
 Find and replace
 Spelling and grammar
 Page setup and page layout
 Page breaks
 Page numbers in footers
 Insert textbox
 Insert headers and footers
 Change page colour
 Insert watermarks
 Indents
 Bullets and numbering
 Tabs
 Columns
 Inserting and formatting tables
 Alignment
 Convert table into text

21.

Solving Problems in Word Processed Documents
Pressing ‘F1’ will access Word Help in Microsoft Word. Use the search bar to find the help you are
looking for and the dialogue box will bring up a list of possible articles that will help you.

22.

The Review Function
Spelling errors in Microsoft Word and Open Office are both underlined in red. In Microsoft Word,
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grammar errors are underlined in green.
To fix these errors, you can either right click on the underlined word, or go to the ‘Review’ ribbon
and click on ‘Spelling & Grammar’ in the ‘Proofing’ group. This will bring up a dialogue box which will
present each error to you with suggestions on how to fix them.
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LINKED ONLINE TUTORIALS (How To’s)

Microsoft Office

Here is a list of the titles of How To’s that are related to the multimedia and video lessons about
word processing. Some cover word processing in Microsoft Office 2010 and others cover word
processing in Open Office.

1.
2.
3.
4.
5.
6.
7.
8.
9.
10.
11.
12.
13.
14.
15.
16.
17.
18.
19.
20.
21.
22.
23.
24.
25.
26.
27.
28.
29.
30.
31.
32.
33.
34.
35.
36.
37.
38.
39.
40.
41.

Solutions Development - Word Processing
First Looks
File Management
Using Templates
Working with Text
Selecting Text
Formatting Marks
Formatting I – Colour and Style
Formatting II – Paragraphs
Formatting III – Quick Styles
Basic Editing
Reviewing Word
Autocorrect and Basic Typography
Page Setup I
Page Setup II
View Options
Enhance your Typing Skills
Inserting Pictures, ClipArt and WordArt
Inserting Charts and SmartArt
Working with Text Boxes
Customising Margins
Headers and Footers
Bullets and Numbers
Indents
Working with Tabs
Working with Columns
Creating Tables
Styling Tables
Layout in Tables
Resizing Parts of Tables
Alignment in Tables
Arranging Contents in Tables
Working with Data in Tables
Viewing Documents in Different Ways
Reviewing – Comments
Reviewing – Protecting Documents
Integrating with Hyperlinks
Accessing Offline Help and FAQs
Troubleshooting Basic Word Processing Problems
Types of Graphs to Use
Making Graphs
Graphs – Interpreting Information
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Open Office

1.
2.
3.
4.
5.
6.
7.
8.
9.
10.
11.
12.
13.
14.
15.
16.
17.
18.
19.
20.
21.
22.
23.
24.
25.
26.
27.
28.
29.
30.
31.
32.
33.
34.
35.
36.
37.
38.
39.
40.
41.

First Looks
File Management
Using Templates
Working with Text
Selecting Text
Formatting Marks
Formatting I – Colour and Style
Formatting II – Paragraphs
Formatting III – Quick Styles
Basic Editing
Reviewing Word
Autocorrect and Basic Typography
Page Setup I
Page Setup II
View Options
Enhance your Typing Skills
Inserting Pictures, ClipArt and WordArt
Working with Text Boxes
Customising Margins Version 1
Headers and Footers Version 1
Bullets and Numbers
Indents
Working with Tabs
Working with Columns
Creating Tables
Styling Tables
Layout in Tables
Resizing Parts of Tables
Alignment in Tables
Arranging Contents in Tables
Working with Data in Tables
Viewing Documents in Different Ways
Reviewing – Comments
Reviewing – Protecting Documents
Integrating with Hyperlinks
Accessing Offline Help and FAQs
Troubleshooting Basic Word Processing Problems
Types of Graphs to Use
Making Graphs
Graphs – Interpreting Information
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Solutions Development - Spreadsheets
1.

What are Spreadsheets?
A spreadsheet is an electronic document that allows you to store and compare data. They can be
used for budgets, entering marks, and a variety of other tasks.
Microsoft Excel looks very similar to Microsoft Word. The top section has tabs which open different
ribbons.
Calc, Open Office’s spreadsheet tool, also has a similar presentation to its word processing tool. It
has tabs with drop down menus and icons.
A spreadsheet consists of columns and rows. The rows are numbered starting at 1. The columns are
labelled with letters. Each individual block is called a cell. A bar at the top is used for inputting data.
In Excel this is called a formula bar, but in Calc, it is called an input bar.

2.

Differences in Data Types and Locations
Every cell in a spreadsheet has it’s own address determined by the column and row number. For
example, cell B3 is the cell which lies at the intersection of column B and row 3. To write in this cell,
the cell needs to be selected.
To highlight a column or a row, hover over the label until the cursor changes to a black arrow, and
then click on it.
To select a number of adjacent cells, left click and drag the cursor over the cells.
The select non-adjacent cells, hold the control key down as you make your selection.
When using a formula to do a calculation, it’s important to use the cell reference.

3.

Basic First Steps with Data and Files
To move to a cell just below a selected cell, press enter. If you would like to move to the right of a
selected cell, press the tab key or the right arrow key.
To enter or edit data in Excel, select the cell and type. If you prefer, you can select the cell, then type
the data in the formula bar.
To copy data, select the cells you wish to copy and either right click and chose ‘copy’, or press CTRL
and C on the keyboard. To paste the data elsewhere, right click on the destination cell and select
‘paste’, or select the destination cell and press CTRL and V on the keyboard.
A workbook can contain multiple worksheets. The tabs for these appear on the bottom of the
window.
To save a workbook, click on File and the Save or Save As depending on your needs.
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4.

Formatting Parts of Spreadsheets
To align text within a cell, select the cell and click on ‘center’ in the Alignment group in the Home
ribbon. To Merge & Centre cells, select the cells and click on the button in the Alignment group in
the Home ribbon.
To change fonts, select the cell and use the buttons locates in the Font group of the Home ribbon.
To make the columns or rows bigger or smaller, left click on the wall of the row or column and drag it
to the desired size.
To wrap the text in a cell so that it all fits within the block, right click on the cell and select ‘Format
Cells’. A new dialogue box will pop up. Go to the ‘Alignment’ tab and place a check in the box next to
‘Wrap text’. You will find this option under the heading ‘Text control’. Click ‘OK’.
In the same ‘Alignment’ tab, you will be able to change the horizontal and vertical alignment of the
text. This will place the text in different parts of the cell.
To place borders around cells, right click on the highlighted cells and select ‘Format Cells’. Then
navigate to the ‘Border’ tab. The tab is divided into two parts, the ‘Line’ type is where you can
choose how the line will look, and location of the line can be set using ‘Presets’ and ‘Border’ on the
other side of the tab. Once you are satisfied with the appearance of the border, click ‘OK’ and your
changes will be applied to the sheet.
The AutoFill function helps us to fill in a sequence of cells efficiently. For example, AutoFill could
automatically fill in days of the week in separate cells within a row or a column. It could also do
automatic numbering. To use this function, rest your cursor above the bottom right corner of a
selected cell. When the cursor changes to a black cross, left click and drag to fill the required cells
with the desired data.
To insert a new row, right click on the row and select ‘Insert’. The new row will be inserted above the
selected row. Follow the same process to insert a column. Right click on the column and select
‘Insert’ and a new column will appear to the left. To delete a column or row, right click on it and
select ‘Delete’.
To hide a column or a row, select it and right click and select ‘Hide’. To unhide it, select the columns
or row on either side of the hidden sheet, right click and select ‘Unhide’.
To change the way the sheet will print, go to the ‘Page Layout’ ribbon. In this ribbon you’re able to
change the size of the margins, the size of the paper the sheet will be printed on and whether the
sheet will be printed as landscape or portrait. Using the ‘Page Setup’ dialogue box, you can also
choose if you would like to print the table in the centre of the page, whether horizontally and/or
vertically, in the ‘Margins’ tab.
To view what the spreadsheet will look like before printing it, go to the ‘File’ ribbon and select ‘Print’.
A print preview will be displayed.

5.

Working with Spreadsheets
IT’s a good idea to name your sheets so that you can find what you’re looking for quickly. To rename
a sheet, right click on the default sheet name on the bottom tab and click ‘Rename’. Then type in
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the new name and press enter. To put the tab in a different colour, right click on the tab and hover
over ‘Tab Colour’. Then click on the desired colour.
To insert a new sheet, click on the new sheet tab which looks like this:
appear.

A new sheet will

To insert a header or footer, go to the ‘Insert’ ribbon and the ‘Text’ group. Click on ‘Header &
Footer’. The header (at the top) and footer (at the bottom) will automatically appear and look like a
text box. Type your text into the box and add the desired fields like ‘Page Number’ or ‘Current Date’.
These fields will update automatically.
6.

Sorting and Filtering
Before doing any sorting, highlight all the data you’d like to sort. Then go to the ‘Sort & Filter’ group
in the ‘Data’ ribbon. Click on ‘Sort’ and a new dialogue box should open. Choose which column you’d
like to ‘Sort by’ by clicking on the drop down arrow. Then you can choose what you’d like to ‘Sort On’
and in which ‘Order’. To add another level of sorting, click the ‘Add Level’ button and follow the
same process as before.

7.

Calculations, Formulae and Functions I
One of the biggest advantages of using Excel is it’s ability to perform calculations for you. Because
the calculations use cell references rather than numbers, calculations are automatically updated
when the values in cells are changed.
A function is a predefined spreadsheet formula that will do a calculation for you, and a formula is like
an equation that you would type in to do a calculation.
Use the following operators to perform calculations:
 Plus
+
 Minus –
 Multiply *
 Divide /
Here are a list of error indicators and how to fix them:
Indicator
Reason
#######
Column too narrow
#NAME?
Wrong function name or
typing error
#DIV/0!
The formula is trying to divide
by zero (mathematically
impossible)
#REF!
The cell reference in the
formula is no longer valid. (cell
was deleted)
#N/A
Formula is referring to a cell
that is no longer available
#VALUE!
Incorrect value used in a cell
(e.g. trying to multiply a text
value)

Solution
Widen the column
Check spelling
Change the cell reference

Change the cell reference to
refer to the correct cell
Correct the cell reference
Change the value to a number

The Count function will count the number of elements you have in a spreadsheet. ‘CountA’ counts
words and ‘Count’ counts numbers. To use this function, first type ‘=’ and then select ‘Count’ and the
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range of cells you’d like to count. Press enter. The range of cells will look something like this
(B2:B32). This means that the function will count from B2 to B32.
To calculated the total value or the sum of a range of cells, press ‘=’, select ‘SUM’ and the range of
cells, press enter.
To calculated the average value of a range of cells, press ‘=’, select ‘AVERAGE’ and the range of cells,
press enter.
If you’d like to change the number of decimal places displayed, right click on the cell and select
‘Format Cells’. Go to the ‘Number’ tab and select ‘Number’ in the ‘Category’ window. Then select the
number of decimal places you’d like to display and press ‘OK’.
To find the highest value in a range of cells, we would use the ‘MAX’ function. To find the minimum
value, use the ‘MIN’ function. Press ‘=’, select the desired function and the range of cells and press
enter.
There are also functions that will find the median and the mode of a range of cells. Once again, press
=, select the function and the range of cells, and press enter.
8.

Calculations, Formulae and Functions II
To insert the current date into a spreadsheet, type ‘=today()’ and press enter.
To insert the current date and time, type ‘=now()’ and press enter.
The Rand function will choose a random number between 0 and 1. To use this, type ‘=rand()’ and
press enter.
To round off a number in a separate cell, type ‘=round(‘ and then insert the cell reference, a comma,
and the number of decimal places, and close the brackets and press enter. The function look
something like this ‘=round(B2,2)’.
The countif function will count the number of values that conform to a set of conditions. These
conditions can be defined using the greater than (>), less than (<) or equals to (=) symbols. To use
this, type = and select the COUNTIF function. An example of how this will look is
‘=COUNTIF(B2:B32,”<2”)’. If you wanted to count the number of people who answered yes to a
question, the function would look like ‘=COUNTIF(B2:B32,”yes”)

9.

Preparing for Printing
When you go to ‘Print’ in the ‘File’ tab, you will be able to choose whether you want to print the
whole workbook, the active sheet or a selected area.
The whole workbook will print all of the worksheets within the workbook.
When you print the active sheet, you will only print the sheet currently open in the workbook.
To print a selected area, you can either highlight the area and then go into the ‘Print’ menu and
select ‘Print Selection’, or you can set the print area. You would do this by highlighting the cells you
wish to print, then go to ‘Print Area’ in the ‘Page Layout’ ribbon and select ‘Set Print Area’. To clear
this print area, just click ‘Clear Print Area’. You would print as normal then.
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10.

Working with Graphs in Spreadsheets
To make a column chart, first you need to select the data you’d like to include. Then click on the
down arrow next to the column chart button in the ‘Insert’ ribbon. The chart will automatically
appear.
To edit anything in the chart, click on it and change it. To add an axis label, go to the ‘Layout’ ribbon
and click on ‘Axis Title’. Choose if you would like to add a horizontal or vertical title and then type in
the text you’d like to include.
To change the positioning and appearance of the legend, click on the ‘Legend’ button in the ‘Layout’
ribbon and select the chosen position.
Inserting a pie chart is just as easy. First highlight the data you’d like to include. Then click on the
down arrow next to the pie chart button in the ‘Insert’ ribbon. The chart will automatically appear.
To reposition the chart, just right click and drag it to the desired position.
To insert a chart title, click on ‘Chart Title’ in the ‘Layout’ ribbon and select the type of title you’d like
to use. Type in the title.
If you would like to insert more information about the sections of the pie chart, click on the arrow
next to ‘Data Labels’ in the ‘Layout’ ribbon and select ‘More Data Label Options’. A dialogue box will
open allowing you to choose what sort of information you’d like to display in the data label.
To change the colour of an individual section of the pie chart, click on it twice so that it is the only
section that is highlighted. Then right click on it and choose ‘Format Data Point’. Go to ‘Fill’ and
change the colour.
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LINKED ONLINE TUTORIALS (How To’s)

Microsoft Office

Here is a list of the titles of How To’s that are linked to the multimedia and video lessons about
spreadsheets. Some cover spreadsheets in Microsoft Office 2010 and others cover spreadsheets in
Open Office.

1.
2.
3.
4.
5.
6.
7.
8.
9.
10.
11.
12.
13.
14.
15.
16.
17.
18.
19.
20.
21.
22.
23.

Solutions Development - Spreadsheets
First Looks
The Ribbon
Customise the Quick Access Toolbar
File Options
About Workbooks and Worksheets
Data Types
Cell References
Inputting Data
Formatting Cells
Formatting Rows, Columns and Sheets
Basic Formatting
Basic Calculations
Error Indicators I
Error Indicators II
Formulae vs Functions
Using Functions I
Using Functions II
Using Functions III
Rounding Numbers using Cell Formatting
Sorting and Filtering
Managing Worksheets I
Managing Worksheets II
Graphs in Spreadsheets
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Open Office

1.
2.
3.
4.
5.
6.
7.
8.
9.
10.
11.
12.
13.
14.
15.
16.
17.
18.
19.
20.
21.
22.
23.

First Looks
The Ribbon
Customise the Quick Access Toolbar
File Options
About Workbooks and Worksheets
Data Types
Cell References
Inputting Data
Formatting Cells
Formatting Rows, Columns and Sheets
Basic Formatting
Basic Calculations
Error Indicators I
Error Indicators II
Formulae vs Functions
Using Functions I
Using Functions II
Using Functions III
Rounding Numbers using Cell Formatting
Sorting and Filtering
Managing Worksheets I
Managing Worksheets II
Graphs in Spreadsheets
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1.

Solutions Development - Presentations
What are Presentations Used For?
Visual presentations can be used to assist people who need to make presentations to groups of
people. In these presentations, they could show graphs, pictures and diagrams which support the
points they are making in the presentation.
Presentations can also be printed out so that listeners could take home a copy. These presentations
would include statistics and information within in point form.
When designing a questionnaire, it’s important to make it appropriate for the audience. If it’s a
corporate event, the presentation should be professional. If the presentation is for a group of
children, then it should have lots of pictures and maybe even a few videos or animations with sound
effects.

2.

Basic Skills for Making Presentations
When you open PowerPoint, a new slide will appear. If you want to add text to the slide, click in one
of the place holder and type. If you want to change the design theme, click on the ‘Design’ ribbon
and select a theme that appeals to you. To view your slide show, click on ‘View’ and select ‘Slide
Show’. To save the presentation, go to ‘File’ and select ‘Save As’. If you want to save the file as
something you can continue to edit, type a name and click save. If you want to save as a PowerPoint
Show, then select it from the dropdown menu under “Save as type”.
When you open Open Office Impress. You will be directed to a presentation wizard. In step one,
you’ll be asked to choose what sort of presentation you want to open. Select ‘Empty Presentation’
and click ‘Next’. In step two you will need to choose a design and the type of output media. The next
step will ask you to choose your slide transitions and then to click ‘Create’. A new slide show will
then open and you’ll be able to create your presentation.
To change the design theme, click on ‘Format’ and then select ‘Slide Design...’. This will open a new
dialogue box where you’ll be able to change the slide design.
To start the show, click on ‘Slide Show’ and then click on ‘Slide Show’ on the drop down menu. Or
you could just press F5.

3.

Getting to Know the Workspace
Microsoft PowerPoint looks very similar to other Microsoft Office offerings. The title bar is at the top
with the saved name displaying in the centre. The ‘File’ tab has a selection of useful functions like
‘Save’ and ‘Print’. The quick access toolbar can be found above the ‘File’ tab and be customised to
include buttons that you use often. The ribbon area contains the tabs ‘Home’, ‘Design’ and others.
The main section of the window is divided into two parts. On the left you can see all of the slides in
the order that they will appear. On the right is the current slide. Below the slide is a section for
notes. These notes can be added to remind the presenter on what to say.
There are two main differences in the workspace in Open Office Impress. There is no ribbon area,
but it does have a menu bar and tool bars in the same area. The notes section is also different to
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Microsoft PowerPoint. The notes will only appear when the slide show is printed with the notes
displayed.
4.

Working with Text in Presentations
There is a difference between moving and copying text. To move text, you would need to ‘cut’ it
from one location and ‘paste’ it in a new location. Copying text happens when you copy a piece of
text to a another location so that there is more than one copy of the text in the presentation. To cut,
copy and paste, you can either select the text, right click on it and select the desired option, or you
can select the text and use the keyboard shortcuts:
Cut: CTRL X
Copy: CTRL C
Paste: CRTL V
Find and Replace are excellent commands to use when you want to change a particular word or
phrase throughout the whole presentation in one or two clicks. To use it, go to the ‘Home’ ribbon
and click ‘Replace’. Enter in the word you want to find, and the word you want to replace it with and
click ‘OK’. A notification box will pop up that shows you how many changes were made
Open Office Impress also has a ‘Find & Replace’ command and this can be found in the ‘Edit’ menu.

5.

Formatting Parts of Presentations
To change the appearance of a selected section of text, go to the ‘Fonts’ group in the ‘Home’ ribbon.
You will be able to change the font, and the size and colour of the text. Choose your colours carefully
so that they will display well on a data projector.
To insert bullet points or automatic numbering, highlight the text and click on the desired button in
the ‘Paragraph’ group of the ‘Home’ tab. You will also find different line spacing options in this
group. Changing the line spacing will change the distance between lines of text.
To insert bullets or numbering in Open Office Impress, select the text and then click on the Bullets
and Numbering button. A dialogue box will open which allows you to choose the style you’d like to
use.

6.

Improving a Presentation
Before you do a presentation in front of people, it’s important to check that everything works in your
presentation, and that there are no errors. It’s sometimes difficult to see errors in your own work, so
get a friend to help check through it.
Start by checking the spelling. Remember that your language should be set on either English (UK) or
English (South Africa). To check your spelling, go to the ‘Review’ ribbon and click on ‘Spelling’. A new
dialogue box will open up and display each spelling error with suggested corrections.
To change the size or shape of the slides, go to the ‘Design’ ribbon and click on ‘Page Setup’.
You can change the margins within each place holder in the ‘Format’ ribbon. Click on the arrow next
to the ‘Shape Styles’ group, and navigate to the ‘Text Box’ section. Once you’re happy with the
margins, click ‘Close’.
To insert a header or a footer, go to the ‘Insert’ ribbon and click on ‘Header & Footer’. A new
dialogue box will open. You can select what you’d like to insert and where you’d like it to appear.
Click ‘Apply to All’ and the dialogue box will close.
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To add a new slide, go to the ‘Home’ ribbon and click on ‘New Slide’. Follow the prompts.
In Open Office Impress, you will find the spell checker in the ‘Tools’ menu. To insert a header or
footer, go to the ‘Insert’ menu and click on ‘Page Number’. This will open the Header and Footer
dialogue box. Follow the prompts and click ‘Apply to all’ to close the dialogue box.
7.

Different Ways to View Presentations
Go to View ribbon and choose the view you’d like. Normal view is the standard view.
Slide sorter is where you can see all of the slides at the same time. This is useful if you have a lot of
slides and want to rearrange the order.
The notes view will show the current slide on a page with a section for the notes.
Reading view will fit your slide to the window.
The outline view just shows the text on all of the slides.
Open Office Impress has the different views as tabs on the top of the slide viewing pane.

8.

Inserting Illustrations and Tables into Presentations
To insert any sort of picture, illustration or chart, go to the ‘Insert’ ribbon
When you click ‘Picture’, it will open a dialogue box where you will need to locate the picture file
you’d like to use. Remember, it is advisable to keep all pictures and movies you use in the
presentation in the same folder as the presentation.
Clipart provides a number of drawn illustrations.
Screenshot allows you to capture a section of your screen and insert it as a picture.
Shapes are useful to put in slides, to provide a bit of interest without distracting from the content on
the slide. You can change the fill and the outline of the shapes.
SmartArt is useful for drawing flow diagrams and mind maps.
Charts include pie charts, column charts, line charts and others.
To insert pictures, illustrations, movies or charts into an Open Office Impress presentation, go to the
‘Insert’ menu and select what you’d like.

9.

Setting Up and Starting a Slide Show
Animations can be fun to setup but if they are used too much, can detract from the presentation. Be
careful when you use them.
To add an animation to an object, click on it and then navigate to the ‘Animations’ ribbon. Select the
animation you’d like to use and the how long you’d like it to be animated for. If you open the
‘Animation Pane’ you’ll be able to manage multiple animations on one slide simultaneously. You can
set in which order they appear and how they are activated.
To run your show, navigate to the ‘Slide Show’ ribbon and choose whether you’d like to start the
show from the beginning, or from the current slide. Alternatively, you could just press F5 and start
the show immediately.
Open Office Impress has animation settings in the ‘Slide Show’ menu. Click on it and navigate to
‘Custom Animation Settings’. This will open an animation pane very much like the one found in
Microsoft PowerPoint.

10.

Linking Other Applications to Presentations
Action buttons are buttons that can be clicked within a presentation. These could take the user back
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to the beginning of the presentation, or to the end, or to another slide. To insert one of these,
navigate to the ‘Insert’ ribbon, click on ‘Shapes’ and scroll to the bottom. Choose the action button
you’d like to use and draw it on the slide. Once you’ve done this, a wizard will open that guides you
through the next steps.
A hyperlink can link to another page within the same presentation, another file (like a Word
document) or a website. To insert one, select the word or picture you’d like to be linked, navigate to
the ‘Insert’ ribbon and click on ‘Hyperlink’. The prompts will guide you on the next steps.
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LINKED ONLINE TUTORIALS (How To’s)

Open Office

Microsoft Office

Here is a list of the titles of How To’s that are linked to the multimedia and video lessons about
presentations. Some cover presentations in Microsoft Office 2010 and others cover presentations in
Open Office.

1.
2.
3.
4.
5.
6.
7.
8.
9.
10.
11.
1.
2.
3.
4.
5.
6.
7.
8.
9.
10.
11.

Solutions Development - Presentations
First Looks
Basic Formatting
Formatting Paragraphs
Working with Text
Reviewing & Proofing
Page Layout
Customising Slides
View Options
Insert Illustrations & Tables
Animations
Special Techniques
First Looks
Basic Formatting
Formatting Paragraphs
Working with Text
Reviewing & Proofing
Page Layout
Customising Slides
View Options
Insert Illustrations & Tables
Animations
Special Techniques
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